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About the Transaction 
Management Application 

The Transaction Management application is a real-time authorization and settlement system within 
Fusebox.  It allows you to search for, manage, and create new transactions through a single, 
browser-based portal. 

Different levels of access provide flexibility and security defined in accordance with user profiles. 
Role-based security determines who can view certain information and alter or create transaction 
data.  

Authorized Transaction Management users can: 

• Search for transactions based on a variety of criteria  
• Research and resolve transaction issues 
• Edit transaction data 
• Copy transaction data  
• Reverse transactions 
• Void transactions  
• Export transaction data 
• Create new Transactions 
• Print receipts 

Before You Begin 
Prior to using the Transaction Management software, you must have a valid username and 
password that is established by a System Administrator based on your company’s profiles and your 
roles. Refer to the Fusebox User Setup Administration Guide for more information. 

Chrome is the preferred browser for Fusebox, however, Fusebox is also supported on Firefox and 
Edge browsers. 
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Using Transaction Management  

This chapter contains information for how to Access Transaction Management, how user security levels 
function, and how to set up transaction management alerts and preferences. 

Accessing Transaction Management 
The Fusebox Transaction Management application is easy to use and incorporates standard web-
based browser navigation features such as tabs, menus, links, and buttons.  

1. Select Transaction Management from the Fusebox Home tab, as shown below. The Search 
screen appears by default and is described in the next section. 

 
 

User Access Security Levels 
Your ability to perform specific functions or view certain information in Fusebox Transaction 
Management is based on access permissions tied to your user profile.  Your permissions enable 
access to the specific information you see in the Transaction Management application. 

You can be assigned to multiple profiles in the Fusebox portal. For example, you can be assigned to a 
Transaction Management profile that gives you entitlements to perform specific functions in the 
Transaction Management application and a Reporting profile that grants you access to a list of 
default reports within the Reporting application of Fusebox.  

However, you should not be assigned to multiple profiles within any application.  

NOTE:  The External Administrator profile is established at the system-level and provides 
permissions to add, delete, and modify users and to unlock a locked-out user. 

The following table provides the default user profile types and level of access required for each type. 
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Profile Type Level of Access 
View Only Transaction Management User 

• Search and view transactions 
• View transaction and life cycle detail 
• Export transaction list 
• View transaction notes 
• Receive transaction alerts 

 
Research and Correction Transaction Management User 

• Search and view transactions 
• View transaction and life cycle detail 
• Export transaction list 
• Create any new transaction 
• Return transactions (credit) 
• Edit and void transactions (prior to being settled) 
• Receive transaction alerts 
• Add and view transaction notes 

 
Full Deposit Transaction Management User 

• Search and view transactions 
• View transaction and life cycle detail 
• Export transaction list 
• Create any new transaction 
• Return transactions (credit) 
• Edit and void transactions (prior to being settled) 
• Add and view transaction notes 
• Receive transaction alerts 

 
Full Deposit + Admin All entitlements for Full Deposit profile and the following 

administrator permissions: 
• Manage password reset 
• Make user configuration changes 
• Add, change, and deactivate users 

 
Deposit - Maker Transaction Management User 

• Search and view transactions 
• View transaction and life cycle detail 
• Export transaction list 
• Create any new transaction 
• Return transactions (credit) 
• Edit and void transactions (prior to being settled) 
• Add and view transaction notes 
• Receive transaction alerts 

 
Deposit - Checker Transaction Management User 

• Search and view transactions 
• View transaction and life cycle detail 
• Export transaction list 
• Add and view transaction notes 
• Receive transaction alerts 
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How to Set Up Transaction Management Alerts  
The Fusebox Home screen provides a central area where you can view alerts and summaries that 
relate to declined transactions, approved transactions, and transactions with errors.  Alerts are 
system-generated notifications that provide links to transactions that may require your attention.  

NOTE: This information is only available to you if your User Preferences setting includes Alerts.  See 
the User Preferences section of the Fusebox User Setup Guide for more information. 

To setup your preferences to get alerts, perform the following steps:  

1. Click on the Account Menu icon that is located at the top, right side of the Fusebox 
Home screen (or any other menu screen), then select Settings.    

2. The Settings page displays and is similar to the example shown below. You will see the 
Alerts option under Notifications.  

3. Select Alerts. 
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4. Once you select Alerts under Notifications, you will receive notifications about Transactions. 
You can also click the “View Alerts” button, if necessary, to access the Alerts page. Example 
notifications are shown in the image below with boxes around them to better call out 
attention to their locations on the Home screen. 
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How to Set Up Transaction Management Preferences 
Transaction Management entitlements allow you to select several preferences for how transactions 
appear on the Home tab. To set these up, follow the steps below. 

1. Click on the Account Menu icon that is located at the top, right side of the Fusebox 
Home screen (or any other menu screen), then select Settings.    

2. The Settings page displays and is similar to the example shown below. Under User Setting 
menu item, you will find the setting for Batches, which relate to Transaction Management 
settings, as well.   

 

 

Your choices include the following options. 

Transaction List sort by - Specifies how the list of records in the Transaction List screen is 
sorted. It can be by Site ID – Card Type or Site ID – Date/Time. 
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All BMUI and FBA List Screens - Rows per page - Specifies the number of records (rows) that 
appear on each screen in the Transaction List of results.  

Save My Previous Transaction Search Date Range - This keeps the date range information 
available from the previous transaction search.  
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Working with Transactions  

Once transactions are located in Transaction Management, you can perform a variety of actions 
provided you have security access and permissions.  You can view property and site details, edit, 
copy, reverse, void, print, export, add notes.  Each of these is explained in the sections below. 

As you enter the Transaction Management portal, you land on the Transaction Search screen by 
default. This screen is used to search for Transactions that have previously taken place in Fusebox.  

There are two search options: Simple Search and Advanced Search. Simple Search is explained in 
this section, and the Advanced Search instructions are found toward the end of this document. 
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How to Search for a Transaction Using Simple 
Search 

Fusebox defaults to the Simple Search screen, shown below, upon logging in to the Transaction 
Management portal. 

 

The Simple Search allows you to search for a transaction or transactions using any of the following 
search criteria.  

Date Range - Enter a “Start Date” and an “End Date” during which time the transaction(s) occurred.  
You can do this by manually entering the date or by selecting the calendar icon to use the interactive 
monthly calendars. 

Site ID – You can enter up to five system-assigned Site ID numbers where the transaction(s) 
occurred. Clicking on the plus (+) symbol located at the left of the “Side ID” field produces an 
additional field where the Site ID’s can be added.  You can remove a site by selecting “Remove Site” 
button that appears when multiple sites are added.  Note that a Site ID may or may not be assigned 
to a POS device or workstation. 

Account Number or Last 4 – You can enter the full card number or the last four digits only.   

Authorization Code – You can enter the Authorization Code for a specific transaction. 

Amount – You can enter a minimum amount and/or a maximum amount using the “Range of 
Amounts” option, or you can use the “Specific Amounts” option to enter an exact amount of a 
transaction. 
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Views – This allows you to indicate how you want to view the results of the search based on the 
following:  

• Financial-Approved – These transactions appear on the merchant/cardholder statement.  

• All-All – All transaction types in all statuses. This is the default value. If you want to view the 
authorizations on an account, which is common in the lodging industry, you must use the 
All-All. 

• Financial/Auth-Approved – Financial approved transaction types including authorizations. 

• Fin/Auth-Decline/Error in Open Batch –Financial transaction types that are declined or 
have errors in an Open Batch. 

• All-All in Open Batch –All transaction types in an Open Batch. 
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How to Search for a Transaction Using Advanced 
Search  

The Advanced Search feature of Transaction Management provides a way to refine your search for 
transactions. In addition to the information on the Simple Search screen, the Advanced Search 
allows you to sort by the information explained below. 

1. Access the Advanced Search screen by selecting the Advanced option from the Simple 
Search screen, as shown below.  

 

The Advanced Search screen displays as shown below.  
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There are five main sections of this Advanced Search screen.   

• Account 

• Payment 

• Batch 

• View 

• User 

Each of these main sections are broken down below. 
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Account 
The Account section of the Advanced Search screen, shown below, is used to search by information 
specific to an account.  You can enter as much or as little of the information about the account as is 
available. The two items that have a plus sign (+) located at the right side of the field can contain up 
to five numbers.  

 

Each field is explained below. 

• Account Number – the specific number of an account.  You can enter the full account 
number of the last four digits of an account. If you enter just the last four digits, it is advised 
that additional search criteria be included to narrow your search results. 

• Site ID – ID of a particular site where the transaction(s) occurred. You can add up to 5 Site 
IDs using the plus sign (+) located at the right of the field. 

• Entity ID – The ID of the specific property or location of the Site.  

• Token ID – A unique reference number assigned by the system to a transaction. 

• Reference Number – A unique reference number that is typically generated by a POS or 
terminal for each transaction. You can add up to 5 reference numbers using the plus sign (+) 
located at the right of the field. 

• Client Reference Number – An internal reference number assigned to the original sale by 
the merchant that is used for their internal tracking purposes. 
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• Aud Transaction ID – A unique identifier for a transaction assigned by Fusebox.  

• Employee ID – The code or name of the person operating the POS at the merchant location 
(for example, cashier or server). 
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Payment 
The Payment section of the Advanced Search screen, shown below, is used to search by information 
specific to the payment method for the transaction.  You can enter as much or as little of the 
information about the payment as is available.  You can select multiple payment types or use the 
“All” checkbox to select all payment types at once. 

 

Each field is explained below. 

• Payment Type – The type of payment used for the transaction. Payment Types include: 

o  0 – Unknown 

o 10 – Credit Card 

o 20 – Check 

o 25 – Private Label (can only viewed; created, edited, voided, and copy are grayed 
out) 

o 30 – Debit Card 
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o 40 – EBT  

o 50 - Stored Value/Gift 

o 55 – Electronic Credit Ap 

o 85 – Cash 

• Card Type – The name of the card association or issuer.  You can use select multiple card 
types or use the “All” checkbox to select all card types at once. These include: 

o AX – American Express 

o DI – Discover 

o JC – JCB  

o MC – MasterCard 

o VI – Visa 

o DC – Diners 

o CK – Check Service 

o SF – PL Symphony 

o DB – Debit 

o ID – Interactive Debit 

o EB – EBT 

o SV – Stored Value 

o PG – Paymentech Gift 

o GV – Gift Card Givex 

o VL – Gift Card Valuelink 

o BH – Gift Card Blackhawk 

o VG – Gift Card Vantiv 

o VC – Gift Card ValuTec 

o IC – Instant Credit 

o CA – IVU/CASH 

• Auth Code – The code provided to the merchant by the issuing financial institution for the 
transaction. It is a code that is returned from the card issuer or authorizing institution 
indicating an approved authorization request. 

• Range of Amounts –Range of amounts of the transaction, or you can select “Specific 
Amount” to search for the specific amount of the transaction. 
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• TPP MID – This the Merchant Identification Number. You can add up to five TPP MIDs using 
the plus sign (+) located at the right of the field. 
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Batch 
The Batch section of the Advanced Search screen, shown below, is used to search for transactions 
by their specific batch information. The information shown in the Batch Status section will vary 
based on your system permissions.  

 

Each field is explained below. 

• System Batch No – This is the system-generated Batch Number 

• Merchant Batch No – This is the merchant-generated Batch Number 

• Batch Status – The search information shown in this section will vary based on whether you 
are searching for information as an internal user or an external user. All options can be 
selected at once by checking the All box at the top of the list. 

• Start Date and End Date –You can further refine the search results by entering a start date 
and an end date range of a specific batch.  These fields are required unless the “Any Date” 
box below these two fields is checked. 

• Any Date – This field removes the Start and End Date fields from being required, thus 
allowing any date to be included in the search. 
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• Enter Time – You can also further refine the search results by selecting the “Enter Time” box 
to narrow the search to a specific time. 

• File Number – This is the specific number of the Batch File.   
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View 
The View section of the Advanced Search screen, shown below, allows you to filter how the search 
results will appear in relation to their transaction type and transaction status.  

 

Each View option is explained below.  They are listed with transition type first, followed by status.  

 

NOTE: Financial Transaction Types include: Sale, In Store Payment, Prior-Authorized Sale, and 
Return. 

 

• Financial-Approved – These transactions appear on the merchant/cardholder statement. If 
you want to view the authorizations on an account, which is common in the lodging 
industry, you must use the All-All or the Manually Select Options | Transaction Type 
options. 

• All-All – All transaction types in all statuses. This is the default value. 

• Financial/Auth-Approved – Financial approved transaction types including authorizations. 

• Fin/Auth-Decline/Error in Open Batch –Financial transaction types that are declined or 
have errors in an Open Batch. 

• All-All in Open Batch –All transaction types in an Open Batch.  

• Manually Select Options – When this option is chosen, you can manually narrow the search 
results by Transaction Types, a status of Approved, or various other status types, as shown 
below.   
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User 
The User section of the Advanced Search screen, shown below, allows you to set up filters specific 
to your facility. These can aid in searches by limiting the search results and producing quicker search 
results.  
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How to View Search Results 
Once you have entered all of your search criteria and selected the Search button at the top right of 
the screen, the Transaction List will appear.  

NOTE: If your search criteria is too broad, an error message will appear stating, “Estimated volume 
exceeds limits.  Please include more narrow date range or additional search filters.” 

 

 

By default, the Transactions List displays the most recent transactions at top of the list.  However, 
you can reorder the list by clicking on any of the column headings to regroup your list by that 
option. 

 

NOTE: Search Criteria is automatically retained when a search is completed unless no data is 
returned with that particular criterion. 

 

Located at the bottom of the Transaction List is a “Rows per page” option that can be used to 
display results in either 25, 50, or 100 rows.  
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How to View Transaction Details 
1. Use the Search function to perform your search. The Transaction List of results appears. 

2. Select the number under the Property ID column to view information about the property, 
such as Name, ID, Entity ID, etc.  

 

 

3. Use the Property tab to review the Property information and use the Site tab to review 
information relevant to the site. You can also click on the “Site ID” hyperlink in the 
Transaction List to view property and site details. 
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How to Edit Transaction Details 
Existing transaction information may be modified, provided you have proper system permissions.  
The Modify tab for each listed menu item contains only that information which is editable.  The 
Review tab, however, shows all information for that particular transaction in a read-only format. 
You can submit edit, copy, and reverse transactions from the Modify or Review tab. 

 

 
1. Use the Search function to perform your search. The Transaction List of results will appear.  

2. Select the number in the Reference column of the transaction you want to edit.  

3. Select the Edit button located at the top, right side of the screen, as shown below.  

 
4. The Edit Transaction screen will appear where the information can be modified, as needed.  
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5. Modify the transaction information as is appropriate.  

6. Make any applicable notes for the modifications in the Notes area that is provided on each 
Modify screen. 

7. Click Submit.   
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How to Copy an Existing Transaction 
Existing transaction information may be copied, provided you have proper system permissions.  The 
Modify tab for each listed menu item contains only that information which is editable.  The Review 
tab, however, shows all information for that particular transaction in a read-only format. 
Additionally, you can submit edit, copy, and reverse transactions from either the Modify or Review 
tab. 

To copy an existing transaction, use the following steps: 

1. Use the Search function to perform your search. The Transaction List of results appears. 

2. Select the number in the Reference column of the transaction you want to copy. 

3. Select the Copy button located at the top, right side of the screen, as shown below. 

 

The Copy Transaction screen will appear where the information copied can be modified, as needed. 

4. Modify any information, as needed. 

5.  Enter any notes relevant to the transaction in the Notes area. 

6. Click Submit. 

7. You will receive an approval, similar to the example shown below, if the transaction copied 
successfully. 
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How to Reverse an Existing Transaction  
Based on your user profile and entitlements in the system, certain types of transactions can be 
reversed using Fusebox’s Transaction Management portal. These include the following transaction 
types. 

• Sales 

• Prior Authorized Sales  

• Returns 

Transactions also cannot be reversed if they are included in a system batch with a Batch Status of 
“Open.”  

Reverse a transaction by following these steps. 

1. Use the Search function to perform your search. The Transaction List of results appears. 

2. Click on the number in the Reference Number column in the Transaction List. 

3. Select the Reverse button located at the top, right side of the screen, as shown below. 

 

The Reverse Transaction screen appears. It contains two tabs: Modify and Review.  The Modify tab 
for each listed menu item contains only that information which is editable. The Review tab, 
however, shows all information for that particular transaction in a read-only format.  

Additionally, you can submit edit, copy, and reverse transactions from the Modify and Review tab. 
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4. If desired, you can print the receipt using the Print button or return to the Transactions List 
using the buttons at the top, right side of the screen. 
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How to Void a Transaction 
Certain types of Approved Transactions can be voided using Fusebox’s Transaction Management 
portal. These include the following transaction types. 

• Sales 

• Prior Authorized Sales 

• Returns 

Transactions cannot be voided if they are in the following status. 

• Declined  

• Error  

• Exception Transaction 

Transactions also cannot be voided if they are included in a system batch with a Batch Status of 
“Settled” or “Confirmed.” 

NOTE: Once a transaction is voided, it cannot be reversed. 

NOTE: The maximum number of transactions that can be voided at once is 25. 

1. Use the Search function to perform your search. The Transaction List of results appears. 

2. Place a checkmark in the box to the left of the item or items that you want to void in the 
Transaction List.  

3. Select the Void button located at the top, right side of the screen, as shown below. 

 

A screen similar to the example screen shown below will display.   
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4. Add a note explaining the reason for the Void in the Notes area, if desired. 

5. Click Submit. 

Once the transaction is successfully voided, the Void Transaction screen will indicate success as 
shown in the sample screen below. 
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How to View and Print a Receipt 
To view a sales receipt for a transaction, use the following steps:  

1. Use the Search function to perform your search. The Transaction List of results appears. 

2. Click on the number in the Reference Number column in the Transaction List. 

The Transaction Detail screen appears and will be similar to the example screen shown below. 

 

 

 

3. Select the Receipt tab, as shown with the arrow above.   

The View Receipt window appears and will be similar to the one shown below.  
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4. Select the Print button as shown with the arrow above.  The print function will be initiated. 
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How to Export Transactions from the Transaction List 
Transactions can be exported into a .csv file and opened in Microsoft Excel. Up to 500 transactions 
can be exported at one time. If you select more than 500, only the first 500 will export. 

1. Once a transaction or multiple transactions are selected from the Transaction List, select 
the Export link located at the top, right side of the Transaction List screen, as shown below.   

 

A .csv file will be created and can be exported to an Excel file. 
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How to Add Notes to a Transaction  
Notes pertaining to transactions can be added and directly linked within in the Transactions List. You 
can add a note to a single transaction or multiple transactions. 

 
1. Use the Search function to perform your search. The Transaction List of results appears. 

2. Place a checkmark in the box to the left of the item or items in the Transaction List. 

3. Select the Add Notes button located at the top, right side of the screen, as shown below.  

 

The Add Transaction Note popup will appear, similar to the one below. 

 

4. Simply add the note and submit the changes. The information is saved with the 
transaction(s) and is indicted in the Transaction List by the Notes icon, as shown below. 
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How to View the Life Cycle of a Transaction 
The life cycle of a transaction contains all message requests and responses that have been received 
or sent from the merchant associated with transaction. To access the life cycle information, follow 
these steps. 

1. Use the Search function to perform your search. The Transaction List of results appears. 

2. Select the number under the Reference column in the Transaction List for the items you 
wish to view.  

3. The Transaction Detail screen will appear, similar to the example shown below. 

4. Select the Life Cycle tab, as shown with the arrow.   

 

The Transaction Life Cycle history includes the following information.  

• Date/Time 
• Transaction ID 
• Transaction Type 
• Response 
• User ID 
• Transaction Amount 
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How to Manually Create a New Transaction 
 

The Create Transaction feature allows you to manually enter information required to create a new 
transaction for an existing site.  Transactions may be manually added when adjustments need to be 
made to a batch or in cases where the merchant does not have a terminal to process the 
transaction.  

When you create a transaction, Fusebox generates an authorization response that also gives you the 
option to print a receipt for the transaction. 

NOTE:  Based on your user privilege level and user profile as established by your company, you may 
not see all available options or buttons. 

 

1. Select the Create Transaction item from the Transaction Management menu.  The Create 
Transaction screen appears.   

 

 

2. The “Hierarchy” field, which is required, can be populated by typing in the name, or by typing in 
the first letter(s) of the name, then scrolling through the resulting alphabetical list.  Additionally, 
recently entered hierarchy names are listed by default when you click on the down arrow in the 
right side of the “Hierarchy” field.  

3. Once the Hierarchy is entered, the specific site can be located using the Tree structure, as 
shown in the image below, or by entering a specific site name using the Search option, as shown 
in the image the follows the tree structure search screenshot.  Sites can be searched by Site ID, 
DBA Name, Site ID, Inn Code, Store/Facility ID, G-Key Property ID, G-Key Venue ID, S-Key 
Location Name, S-Key Terminal ID, Billing ID, VAR ID, Federal Tax ID, or Business Unit. 
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2. Enter the Site name and/or search for the site name, then select the  button at the 
top right of the screen 

3. The Create Transaction screen will appear and be similar to the one shown below.  

 
 

NOTE: that the fields that appear on the Create Transaction screen vary based on the terminal 
type and industry of the merchant.  For example, if you select the check box for no expiration 
date, the field is no longer required. Also, for the Restaurant industry, there may be “Food 
Amount” and “Tip Amount” fields that would not appear when you are creating a Lodging 
transaction. 

 
 
4. Select whether you are creating a transaction for a specific Token ID or Account Number, 

then enter that number in the field below.  

5. Enter the Expiration Date for the transaction or select the “No Expiration Date” field if the 
date is not relevant. 
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6. Next, enter the Card Holder name, address, zip code, and CVV2/CVC2/CID information if 
available.  

7. Select the type of payment from the Payment field. This field is required. 

8. Indicate the type of the transaction, such as Authorization Only, Balance Inquiry, Prior-
Authorization Sale, Return, or Sale. This information is required to create the transaction. 

9. Enter the amount of the transaction, the reference number, and the authorization code (if 
known). 

10. If there is sales tax on the purchase, enter that in the “Sales Tax” field. 

11. Next, enter the system Batch number, if known. This field defaults to “Virtual Terminal” if 
there are no open batches to which you want to add the transaction. 

12. The User information and any notes pertaining to the why the transaction is being manually 
created.  

13. Enter the additional information as requested by Fusebox. As previously stated, the 
remaining fields will vary based on the industry. 

14. Select the Create Transaction button at the top right of the screen. 

15. Confirm that you want to create the new transaction. 

 
 

The new transaction will be approved, if successful, as indicated below.  

 

You can print the receipt using the Print icon at the top, right of the screen, or continue to create 
another transaction.  
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	About the Transaction Management Application
	The Transaction Management application is a real-time authorization and settlement system within Fusebox.  It allows you to search for, manage, and create new transactions through a single, browser-based portal.
	Different levels of access provide flexibility and security defined in accordance with user profiles. Role-based security determines who can view certain information and alter or create transaction data. 
	Authorized Transaction Management users can:
	 Search for transactions based on a variety of criteria 
	 Research and resolve transaction issues
	 Edit transaction data
	 Copy transaction data 
	 Reverse transactions
	 Void transactions 
	 Export transaction data
	 Create new Transactions
	 Print receipts
	Before You Begin
	Prior to using the Transaction Management software, you must have a valid username and password that is established by a System Administrator based on your company’s profiles and your roles. Refer to the Fusebox User Setup Administration Guide for more information.
	Chrome is the preferred browser for Fusebox, however, Fusebox is also supported on Firefox and Edge browsers.
	Using Transaction Management 
	This chapter contains information for how to Access Transaction Management, how user security levels function, and how to set up transaction management alerts and preferences.
	Accessing Transaction Management
	The Fusebox Transaction Management application is easy to use and incorporates standard web-based browser navigation features such as tabs, menus, links, and buttons. 
	1. Select Transaction Management from the Fusebox Home tab, as shown below. The Search screen appears by default and is described in the next section.
	/
	User Access Security Levels
	Your ability to perform specific functions or view certain information in Fusebox Transaction Management is based on access permissions tied to your user profile.  Your permissions enable access to the specific information you see in the Transaction Management application.
	You can be assigned to multiple profiles in the Fusebox portal. For example, you can be assigned to a Transaction Management profile that gives you entitlements to perform specific functions in the Transaction Management application and a Reporting profile that grants you access to a list of default reports within the Reporting application of Fusebox. 
	However, you should not be assigned to multiple profiles within any application. 
	NOTE:  The External Administrator profile is established at the system-level and provides permissions to add, delete, and modify users and to unlock a locked-out user.
	The following table provides the default user profile types and level of access required for each type.
	 Search and view transactions
	 View transaction and life cycle detail
	 Export transaction list
	 View transaction notes
	 Receive transaction alerts
	 Search and view transactions
	 View transaction and life cycle detail
	 Export transaction list
	 Create any new transaction
	 Return transactions (credit)
	 Edit and void transactions (prior to being settled)
	 Receive transaction alerts
	 Add and view transaction notes
	 Search and view transactions
	 View transaction and life cycle detail
	 Export transaction list
	 Create any new transaction
	 Return transactions (credit)
	 Edit and void transactions (prior to being settled)
	 Add and view transaction notes
	 Receive transaction alerts
	 Manage password reset
	 Make user configuration changes
	 Add, change, and deactivate users
	 Search and view transactions
	 View transaction and life cycle detail
	 Export transaction list
	 Create any new transaction
	 Return transactions (credit)
	 Edit and void transactions (prior to being settled)
	 Add and view transaction notes
	 Receive transaction alerts
	 Search and view transactions
	 View transaction and life cycle detail
	 Export transaction list
	 Add and view transaction notes
	 Receive transaction alerts
	How to Set Up Transaction Management Alerts 

	The Fusebox Home screen provides a central area where you can view alerts and summaries that relate to declined transactions, approved transactions, and transactions with errors.  Alerts are system-generated notifications that provide links to transactions that may require your attention. 
	NOTE: This information is only available to you if your User Preferences setting includes Alerts.  See the User Preferences section of the Fusebox User Setup Guide for more information.
	To setup your preferences to get alerts, perform the following steps: 
	1. Click on the Account Menu icon /that is located at the top, right side of the Fusebox Home screen (or any other menu screen), then select Settings.   
	2. The Settings page displays and is similar to the example shown below. You will see the Alerts option under Notifications. 
	3. Select Alerts.
	/
	4. Once you select Alerts under Notifications, you will receive notifications about Transactions. You can also click the “View Alerts” button, if necessary, to access the Alerts page. Example notifications are shown in the image below with boxes around them to better call out attention to their locations on the Home screen.
	/
	How to Set Up Transaction Management Preferences

	Transaction Management entitlements allow you to select several preferences for how transactions appear on the Home tab. To set these up, follow the steps below.
	1. Click on the Account Menu icon /that is located at the top, right side of the Fusebox Home screen (or any other menu screen), then select Settings.   
	2. The Settings page displays and is similar to the example shown below. Under User Setting menu item, you will find the setting for Batches, which relate to Transaction Management settings, as well.  
	/
	Your choices include the following options.
	Transaction List sort by - Specifies how the list of records in the Transaction List screen is sorted. It can be by Site ID – Card Type or Site ID – Date/Time.
	All BMUI and FBA List Screens - Rows per page - Specifies the number of records (rows) that appear on each screen in the Transaction List of results. 
	Save My Previous Transaction Search Date Range - This keeps the date range information available from the previous transaction search. 
	Working with Transactions 
	Once transactions are located in Transaction Management, you can perform a variety of actions provided you have security access and permissions.  You can view property and site details, edit, copy, reverse, void, print, export, add notes.  Each of these is explained in the sections below.
	As you enter the Transaction Management portal, you land on the Transaction Search screen by default. This screen is used to search for Transactions that have previously taken place in Fusebox. 
	There are two search options: Simple Search and Advanced Search. Simple Search is explained in this section, and the Advanced Search instructions are found toward the end of this document.
	How to Search for a Transaction Using Simple Search

	Fusebox defaults to the Simple Search screen, shown below, upon logging in to the Transaction Management portal.
	/
	The Simple Search allows you to search for a transaction or transactions using any of the following search criteria. 
	Date Range - Enter a “Start Date” and an “End Date” during which time the transaction(s) occurred.  You can do this by manually entering the date or by selecting the calendar icon to use the interactive monthly calendars.
	Site ID – You can enter up to five system-assigned Site ID numbers where the transaction(s) occurred. Clicking on the plus (+) symbol located at the left of the “Side ID” field produces an additional field where the Site ID’s can be added.  You can remove a site by selecting “Remove Site” button that appears when multiple sites are added.  Note that a Site ID may or may not be assigned to a POS device or workstation.
	Account Number or Last 4 – You can enter the full card number or the last four digits only.  
	Authorization Code – You can enter the Authorization Code for a specific transaction.
	Amount – You can enter a minimum amount and/or a maximum amount using the “Range of Amounts” option, or you can use the “Specific Amounts” option to enter an exact amount of a transaction.
	Views – This allows you to indicate how you want to view the results of the search based on the following: 
	 Financial-Approved – These transactions appear on the merchant/cardholder statement. 
	 All-All – All transaction types in all statuses. This is the default value. If you want to view the authorizations on an account, which is common in the lodging industry, you must use the All-All.
	 Financial/Auth-Approved – Financial approved transaction types including authorizations.
	 Fin/Auth-Decline/Error in Open Batch –Financial transaction types that are declined or have errors in an Open Batch.
	 All-All in Open Batch –All transaction types in an Open Batch.
	How to Search for a Transaction Using Advanced Search 

	The Advanced Search feature of Transaction Management provides a way to refine your search for transactions. In addition to the information on the Simple Search screen, the Advanced Search allows you to sort by the information explained below.
	1. Access the Advanced Search screen by selecting the Advanced option from the Simple Search screen, as shown below. 
	/
	The Advanced Search screen displays as shown below. 
	/
	There are five main sections of this Advanced Search screen.  
	 Account
	 Payment
	 Batch
	 View
	 User
	Each of these main sections are broken down below.
	Account

	The Account section of the Advanced Search screen, shown below, is used to search by information specific to an account.  You can enter as much or as little of the information about the account as is available. The two items that have a plus sign (+) located at the right side of the field can contain up to five numbers. 
	/
	Each field is explained below.
	 Account Number – the specific number of an account.  You can enter the full account number of the last four digits of an account. If you enter just the last four digits, it is advised that additional search criteria be included to narrow your search results.
	 Site ID – ID of a particular site where the transaction(s) occurred. You can add up to 5 Site IDs using the plus sign (+) located at the right of the field.
	 Entity ID – The ID of the specific property or location of the Site. 
	 Token ID – A unique reference number assigned by the system to a transaction.
	 Reference Number – A unique reference number that is typically generated by a POS or terminal for each transaction. You can add up to 5 reference numbers using the plus sign (+) located at the right of the field.
	 Client Reference Number – An internal reference number assigned to the original sale by the merchant that is used for their internal tracking purposes.
	 Aud Transaction ID – A unique identifier for a transaction assigned by Fusebox. 
	 Employee ID – The code or name of the person operating the POS at the merchant location (for example, cashier or server).
	Payment

	The Payment section of the Advanced Search screen, shown below, is used to search by information specific to the payment method for the transaction.  You can enter as much or as little of the information about the payment as is available.  You can select multiple payment types or use the “All” checkbox to select all payment types at once.
	/
	Each field is explained below.
	 Payment Type – The type of payment used for the transaction. Payment Types include:
	o  0 – Unknown
	o 10 – Credit Card
	o 20 – Check
	o 25 – Private Label (can only viewed; created, edited, voided, and copy are grayed out)
	o 30 – Debit Card
	o 40 – EBT 
	o 50 - Stored Value/Gift
	o 55 – Electronic Credit Ap
	o 85 – Cash
	 Card Type – The name of the card association or issuer.  You can use select multiple card types or use the “All” checkbox to select all card types at once. These include:
	o AX – American Express
	o DI – Discover
	o JC – JCB 
	o MC – MasterCard
	o VI – Visa
	o DC – Diners
	o CK – Check Service
	o SF – PL Symphony
	o DB – Debit
	o ID – Interactive Debit
	o EB – EBT
	o SV – Stored Value
	o PG – Paymentech Gift
	o GV – Gift Card Givex
	o VL – Gift Card Valuelink
	o BH – Gift Card Blackhawk
	o VG – Gift Card Vantiv
	o VC – Gift Card ValuTec
	o IC – Instant Credit
	o CA – IVU/CASH
	 Auth Code – The code provided to the merchant by the issuing financial institution for the transaction. It is a code that is returned from the card issuer or authorizing institution indicating an approved authorization request.
	 Range of Amounts –Range of amounts of the transaction, or you can select “Specific Amount” to search for the specific amount of the transaction.
	 TPP MID – This the Merchant Identification Number. You can add up to five TPP MIDs using the plus sign (+) located at the right of the field.
	Batch

	The Batch section of the Advanced Search screen, shown below, is used to search for transactions by their specific batch information. The information shown in the Batch Status section will vary based on your system permissions. 
	/
	Each field is explained below.
	 System Batch No – This is the system-generated Batch Number
	 Merchant Batch No – This is the merchant-generated Batch Number
	 Batch Status – The search information shown in this section will vary based on whether you are searching for information as an internal user or an external user. All options can be selected at once by checking the All box at the top of the list.
	 Start Date and End Date –You can further refine the search results by entering a start date and an end date range of a specific batch.  These fields are required unless the “Any Date” box below these two fields is checked.
	 Any Date – This field removes the Start and End Date fields from being required, thus allowing any date to be included in the search.
	 Enter Time – You can also further refine the search results by selecting the “Enter Time” box to narrow the search to a specific time.
	 File Number – This is the specific number of the Batch File.  
	View

	The View section of the Advanced Search screen, shown below, allows you to filter how the search results will appear in relation to their transaction type and transaction status. 
	/
	Each View option is explained below.  They are listed with transition type first, followed by status. 
	NOTE: Financial Transaction Types include: Sale, In Store Payment, Prior-Authorized Sale, and Return.
	 Financial-Approved – These transactions appear on the merchant/cardholder statement. If you want to view the authorizations on an account, which is common in the lodging industry, you must use the All-All or the Manually Select Options | Transaction Type options.
	 All-All – All transaction types in all statuses. This is the default value.
	 Financial/Auth-Approved – Financial approved transaction types including authorizations.
	 Fin/Auth-Decline/Error in Open Batch –Financial transaction types that are declined or have errors in an Open Batch.
	 All-All in Open Batch –All transaction types in an Open Batch. 
	 Manually Select Options – When this option is chosen, you can manually narrow the search results by Transaction Types, a status of Approved, or various other status types, as shown below.  
	/
	User

	The User section of the Advanced Search screen, shown below, allows you to set up filters specific to your facility. These can aid in searches by limiting the search results and producing quicker search results. 
	/
	How to View Search Results

	Once you have entered all of your search criteria and selected the Search button at the top right of the screen, the Transaction List will appear. 
	NOTE: If your search criteria is too broad, an error message will appear stating, “Estimated volume exceeds limits.  Please include more narrow date range or additional search filters.”
	/
	By default, the Transactions List displays the most recent transactions at top of the list.  However, you can reorder the list by clicking on any of the column headings to regroup your list by that option.
	NOTE: Search Criteria is automatically retained when a search is completed unless no data is returned with that particular criterion.
	Located at the bottom of the Transaction List is a “Rows per page” option that can be used to display results in either 25, 50, or 100 rows. 
	/
	How to View Transaction Details

	1. Use the Search function to perform your search. The Transaction List of results appears.
	2. Select the number under the Property ID column to view information about the property, such as Name, ID, Entity ID, etc. 
	/
	3. Use the Property tab to review the Property information and use the Site tab to review information relevant to the site. You can also click on the “Site ID” hyperlink in the Transaction List to view property and site details.
	/
	How to Edit Transaction Details

	Existing transaction information may be modified, provided you have proper system permissions.  The Modify tab for each listed menu item contains only that information which is editable.  The Review tab, however, shows all information for that particular transaction in a read-only format. You can submit edit, copy, and reverse transactions from the Modify or Review tab.
	/
	1. Use the Search function to perform your search. The Transaction List of results will appear. 
	2. Select the number in the Reference column of the transaction you want to edit. 
	3. Select the Edit button located at the top, right side of the screen, as shown below. 
	/
	4. The Edit Transaction screen will appear where the information can be modified, as needed. 
	5. Modify the transaction information as is appropriate. 
	6. Make any applicable notes for the modifications in the Notes area that is provided on each Modify screen.
	7. Click Submit.  
	How to Copy an Existing Transaction

	Existing transaction information may be copied, provided you have proper system permissions.  The Modify tab for each listed menu item contains only that information which is editable.  The Review tab, however, shows all information for that particular transaction in a read-only format. Additionally, you can submit edit, copy, and reverse transactions from either the Modify or Review tab.
	To copy an existing transaction, use the following steps:
	1. Use the Search function to perform your search. The Transaction List of results appears.
	2. Select the number in the Reference column of the transaction you want to copy.
	3. Select the Copy button located at the top, right side of the screen, as shown below.
	/
	The Copy Transaction screen will appear where the information copied can be modified, as needed.
	4. Modify any information, as needed.
	5.  Enter any notes relevant to the transaction in the Notes area.
	6. Click Submit.
	7. You will receive an approval, similar to the example shown below, if the transaction copied successfully.
	/
	How to Reverse an Existing Transaction 

	Based on your user profile and entitlements in the system, certain types of transactions can be reversed using Fusebox’s Transaction Management portal. These include the following transaction types.
	 Sales
	 Prior Authorized Sales 
	 Returns
	Transactions also cannot be reversed if they are included in a system batch with a Batch Status of “Open.” 
	Reverse a transaction by following these steps.
	1. Use the Search function to perform your search. The Transaction List of results appears.
	2. Click on the number in the Reference Number column in the Transaction List.
	3. Select the Reverse button located at the top, right side of the screen, as shown below.
	/
	The Reverse Transaction screen appears. It contains two tabs: Modify and Review.  The Modify tab for each listed menu item contains only that information which is editable. The Review tab, however, shows all information for that particular transaction in a read-only format. 
	Additionally, you can submit edit, copy, and reverse transactions from the Modify and Review tab.
	/
	4. If desired, you can print the receipt using the Print button or return to the Transactions List using the buttons at the top, right side of the screen.
	How to Void a Transaction

	Certain types of Approved Transactions can be voided using Fusebox’s Transaction Management portal. These include the following transaction types.
	 Sales
	 Prior Authorized Sales
	 Returns
	Transactions cannot be voided if they are in the following status.
	 Declined 
	 Error 
	 Exception Transaction
	Transactions also cannot be voided if they are included in a system batch with a Batch Status of “Settled” or “Confirmed.”
	NOTE: Once a transaction is voided, it cannot be reversed.
	NOTE: The maximum number of transactions that can be voided at once is 25.
	1. Use the Search function to perform your search. The Transaction List of results appears.
	2. Place a checkmark in the box to the left of the item or items that you want to void in the Transaction List. 
	3. Select the Void button located at the top, right side of the screen, as shown below.
	/
	A screen similar to the example screen shown below will display.  
	/
	4. Add a note explaining the reason for the Void in the Notes area, if desired.
	5. Click Submit.
	Once the transaction is successfully voided, the Void Transaction screen will indicate success as shown in the sample screen below.
	/
	How to View and Print a Receipt

	To view a sales receipt for a transaction, use the following steps: 
	1. Use the Search function to perform your search. The Transaction List of results appears.
	2. Click on the number in the Reference Number column in the Transaction List.
	The Transaction Detail screen appears and will be similar to the example screen shown below.
	/
	3. Select the Receipt tab, as shown with the arrow above.  
	The View Receipt window appears and will be similar to the one shown below. 
	/
	4. Select the Print button as shown with the arrow above.  The print function will be initiated.
	How to Export Transactions from the Transaction List

	Transactions can be exported into a .csv file and opened in Microsoft Excel. Up to 500 transactions can be exported at one time. If you select more than 500, only the first 500 will export.
	1. Once a transaction or multiple transactions are selected from the Transaction List, select the Export link located at the top, right side of the Transaction List screen, as shown below.  
	/
	A .csv file will be created and can be exported to an Excel file.
	How to Add Notes to a Transaction 

	Notes pertaining to transactions can be added and directly linked within in the Transactions List. You can add a note to a single transaction or multiple transactions.
	1. Use the Search function to perform your search. The Transaction List of results appears.
	2. Place a checkmark in the box to the left of the item or items in the Transaction List.
	3. Select the Add Notes button located at the top, right side of the screen, as shown below. 
	/
	The Add Transaction Note popup will appear, similar to the one below.
	/
	4. Simply add the note and submit the changes. The information is saved with the transaction(s) and is indicted in the Transaction List by the Notes icon, as shown below.
	/
	How to View the Life Cycle of a Transaction

	The life cycle of a transaction contains all message requests and responses that have been received or sent from the merchant associated with transaction. To access the life cycle information, follow these steps.
	1. Use the Search function to perform your search. The Transaction List of results appears.
	2. Select the number under the Reference column in the Transaction List for the items you wish to view. 
	3. The Transaction Detail screen will appear, similar to the example shown below.
	4. Select the Life Cycle tab, as shown with the arrow.  
	/
	The Transaction Life Cycle history includes the following information. 
	 Date/Time
	 Transaction ID
	 Transaction Type
	 Response
	 User ID
	 Transaction Amount
	How to Manually Create a New Transaction

	The Create Transaction feature allows you to manually enter information required to create a new transaction for an existing site.  Transactions may be manually added when adjustments need to be made to a batch or in cases where the merchant does not have a terminal to process the transaction. 
	When you create a transaction, Fusebox generates an authorization response that also gives you the option to print a receipt for the transaction.
	NOTE:  Based on your user privilege level and user profile as established by your company, you may not see all available options or buttons.
	1. Select the Create Transaction item from the Transaction Management menu.  The Create Transaction screen appears.  
	/
	2. The “Hierarchy” field, which is required, can be populated by typing in the name, or by typing in the first letter(s) of the name, then scrolling through the resulting alphabetical list.  Additionally, recently entered hierarchy names are listed by default when you click on the down arrow in the right side of the “Hierarchy” field. 
	3. Once the Hierarchy is entered, the specific site can be located using the Tree structure, as shown in the image below, or by entering a specific site name using the Search option, as shown in the image the follows the tree structure search screenshot.  Sites can be searched by Site ID, DBA Name, Site ID, Inn Code, Store/Facility ID, G-Key Property ID, G-Key Venue ID, S-Key Location Name, S-Key Terminal ID, Billing ID, VAR ID, Federal Tax ID, or Business Unit.
	/
	2. Enter the Site name and/or search for the site name, then select the / button at the top right of the screen
	3. The Create Transaction screen will appear and be similar to the one shown below. 
	/
	NOTE: that the fields that appear on the Create Transaction screen vary based on the terminal type and industry of the merchant.  For example, if you select the check box for no expiration date, the field is no longer required. Also, for the Restaurant industry, there may be “Food Amount” and “Tip Amount” fields that would not appear when you are creating a Lodging transaction.
	4. Select whether you are creating a transaction for a specific Token ID or Account Number, then enter that number in the field below. 
	5. Enter the Expiration Date for the transaction or select the “No Expiration Date” field if the date is not relevant.
	6. Next, enter the Card Holder name, address, zip code, and CVV2/CVC2/CID information if available. 
	7. Select the type of payment from the Payment field. This field is required.
	8. Indicate the type of the transaction, such as Authorization Only, Balance Inquiry, Prior-Authorization Sale, Return, or Sale. This information is required to create the transaction.
	9. Enter the amount of the transaction, the reference number, and the authorization code (if known).
	10. If there is sales tax on the purchase, enter that in the “Sales Tax” field.
	11. Next, enter the system Batch number, if known. This field defaults to “Virtual Terminal” if there are no open batches to which you want to add the transaction.
	12. The User information and any notes pertaining to the why the transaction is being manually created. 
	13. Enter the additional information as requested by Fusebox. As previously stated, the remaining fields will vary based on the industry.
	14. Select the Create Transaction button at the top right of the screen.
	15. Confirm that you want to create the new transaction.
	/
	The new transaction will be approved, if successful, as indicated below. 
	/
	You can print the receipt using the Print icon at the top, right of the screen, or continue to create another transaction. 
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